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Frequently Asked Questions 
 

Hardware 
 

1. Q: What are the actual zero pressures for both the cell and the sample FlowTrac-II 
units at the beginning of a permeability test? 

 
A: The pressure sensor for either FlowTrac-II unit is internally located; therefore any 

column of water inside the tubing up to the cell will be registered at the beginning of the 
test.  This assumes that there are no air bubbles trapped inside the lines.  Conventionally, the 
zero pressure is the mid height of the soil sample in the cell.  To adjust for samples different 
heights, follow these steps for both the cell and sample FlowTrac-II units: 

 
1. At the beginning of the test, open the Output valve (either using the key pad or 

through the PC). 
2. Fill the output line with water, making sure that there are no air bubbles trapped. 
3. Raise the line to the location that corresponds to the mid-height of the soil sample, 

and zero the pressure following the above procedure (by placing the Offset value from 
the System Monitor into the Calibration Summary). 

 
 

2. Q: Can I fill up the permeability chamber using the FlowTrac-II unit? 
 
A: It is not practical to fill up the permeability cell chamber using the FlowTrac-II unit.  

The total volume of water required to fill up the standard (model 3440) permeability chamber 
is  about 2500 cc, and the total volume capacity of the FlowTrac-II unit is 250 cc. 

 
The easiest and most practical way to fill up the permeability chamber is to do so directly 

from the water faucet. 
 
Note: There is no particular requirement for the quality of the chamber water as long as 

the water is potable. 
 
 

3. Q: Do I need to use de-aerated water to fill the FlowTrac-II units?  If so, how do I obtain 
de-aerated water? 

 
A: Yes, it is important to use de-aerated water to minimize air bubbles in the system, and 

speed up the back saturation process.  To prepare de-aerated water, boil water while 
applying a vacuum or use a device such as a Nold DeAerator, which combines propeller 
cavitations with a vacuum to de-aerate the water rapidly. 

 
 

4. Q: How can I change the rate at which the pumps fill during initialization?  The cell 
pressure pump appears to fill at a substantially slower rate than the sample pressure 
pump. 

 
A: The filling and emptying rates during the initialization process cannot be changed. 
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 Filling involves suction; as a result, the filling rate was determined so that it prevents 
cavitation from occurring.  

 
 

5. Q: I am running a permeability test on a compacted sand material.  My saturation ratio 
(Skempton pore pressure coefficient B) does not seem to ever reach the minimum value 
of 0.95 that I specified in the Saturation Table.  Am I doing something wrong?  Is there a 
technique to improve the initial saturation of the sample before starting the test? 

 
A: First, check that your cell and sample 

pressure sensors calibration values are correct.  
Next, there is a technique widely used to improve 
the saturation process:  

 
Flushing the specimen with carbon dioxide gas 

(CO2) to replace as much air as possible prior to 
backpressure saturation is a great way to improve 
saturation because CO2 has higher water solubility 
than air.  

 
Follow these steps:  
 

1. Dip the top drainage line into a small 
container of clear water and open the 
valve.  

2. Connect regulated source of compressed 
CO2 to the drainage line at the bottom of the sample.  

3. Open the valve on the CO2 and slowly increase CO2 pressure until bubbles start 
escaping through the water.  Continue flushing sample with CO2 for about 15 minutes.  

4. Replace the CO2 source with the de-aerated water source.  
5. Apply a small vacuum to the top drainage line to force a slow upward flow of de-

aerated water into the specimen.  Continue until no more bubbles show in the top 
drainage line. 

 
For further info, please refer to: 
 
Rad, N. S., and G. W. Clough (1984).  "New Procedure for Saturating Sand Specimens."  

Journal of the Geotechnical Engineering Division, ASCE, Vol. 110, No. 9, pp. 1205-1218. 
 
 

6. Q: Could the Node ID# for either one of the FlowTrac-II’s change by itself?  What 
possible reasons could you think to have prompted the change? 

 
A: A node ID cannot change by itself.  The imbedded controller default Node ID for each 

FlowTrac-II unit is 66.  The ID for the FlowTrac-II unit used to control sample pressure was 
changed to 67 at the factory before you system was shipped to you.  If the ESC key on the 
keypad was pressed by mistake when the sample pressure unit was booted, then the 
embedded controller in that unit reverted back to the default value. 
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If you suspect that you (or someone) pressed the ESC key during the boot process (on 
either of the FlowTrac-II units), it is important that you check all the LCD menu entries 
against those listed in the table found in the Setup section (Section 2.1.4) in the hardware 
manual for the unit in question. 

 
 

7. Q: We noticed that a lot of the clays in our specimen had been washed to the top flow-
pump.  We think that the flow-pump might need some washing after some time of use.  
What is your opinion?  Do you have a similar experience?  Does the washing of the fine 
materials into the flow pump affect the readings of the pressure transducer? 

 
A: Yes, you do have to flush the FlowTrac-II after extensive use or after a long idle period. 
 
 

8. Q: Is there any required maintenance for the FlowTrac-II units? 
 
A: Except for regular routine pressure sensors calibration, your FlowTrac-II units require 

only a little maintenance, such as flushing and draining after extensive use or anticipation of 
prolonged idle time. 

 
Flushing the FlowTrac-II units is accomplished by draining the FlowTrac-II pump cylinder 

manually, using the Empty command on the front LCD.  Draining must be done into a separate 
container than the one you fill from.  You need to repeat this operation several times or until 
you can see that the drained water is clear.  Leave the FlowTrac-II empty if you are not going 
to use it for an extended period of time. 

 
 

9. Q: We have several units connected to the same PC.  We were running only one of the 
units, so we shut off the remaining units.  Then we got an error message stating that the 
unit was not responding.  It seems that we lost communication with the unit.  What is 
happening? 

 
A: A temporary loss of communication is a normal thing when you either shut off or boot 

up another unit connected to the same network.  Any time a unit connected to the network is 
powered down or powered up, the network goes into a re-configuration mode, during which 
no communication is allowed.  Depending on how many other units are on, this process may 
take some time.  If you're lucky, the Windows software will miss it.  If you're not so lucky, you 
get the normal 'LoadTrac not responding' message.  All you have to do is hit the Retry button 
and you should be all set. 

 
 

10. Q: I noticed that the engineering readings on the LCD screen are different than the 
ones on the PC screen.  Are they supposed to be the same?  Did it affect the results of a 
test I just ran? 

 
A: SYNCHRONIZING LCD AND PC SCREENS: 
 
First, I would like to assure you that the mismatch of the engineering readings values 

between the LCD and the PC screens will not affect the results of any test that you have run 
through the PC software program. 
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Assuming that your calibration factors are correct, or that you have just finished a new 

calibration and need to update the calibration parameters on the embedded controller of a 
LoadTrac-II or FlowTrac-II or ShearTrac-II, you can synchronize the engineering readings 
between the LCD and the PC screen by following these steps: 

 
1. Go to the Calibrate Summary menu 
 

2. Select the sensor that you want to synchronize 
 

  
 

3. Click on the Download button.  This will automatically transfer (copy and save) the 
current calibration parameters (Factor and Offset) into the embedded controller.  
 

4. Repeat the above procedure for the other sensors. 
 
You should now see that the PC and LCD screen values match. 
 
 

11. Q: After an electrical power problem, it seems that the system is not working 
properly.  We suspect that the set-up values on the embedded controller are not correct.  
How do we revert to the original set-up values or default values set at the factory? 

 
A: The default values may change either after an electrical power problem or due to 

inadvertent actions by the end user. 
 
You will need to revert back to the internal default values of your system by following 

these steps: 
 
1. Turn off each FlowTrac-II unit. 
2. Wait about 10 sec. 
3. Turn each back on and immediately press the ESC key on the keypad to reset 

everything back to the imbedded controller default values. 
4. Now go to your FlowTrac-II hardware manual.  In Sections 2.1.4 (Setup section) you 

will find a table of default settings for your system.  Got through each LCD menu and 
be sure the settings on the menu agree with those in the table.  If a setting does not 
agree, change it to the one in the manual. 
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5. If the Node ID numbers on your unit were changed (because you are controlling more 
than one system with your computer), set them to the values they were changed to.  
(The default values are 66 for the FlowTrac-II unit controlling cell pressure and 67 for 
the FlowTrac-II unit controlling sample pressure.) 

 
 

12. Q: In many of our different test files, the calibration values in the Summary Table and 
the values in each sensor's individual calibration table are not in sync.  Could you please 
explain which values the program uses, and how to make sure they are correct?   

 
A: All of the Geocomp Corp. control programs have similar menus for performing the 

calibration of any of the sensors related to the test.  However, you must then copy the 
calibration that you obtained into the Summary Table.  (If you have had to repeat the 
calibration procedure, be sure to use the correct value.) 

 
The calibration factors in the Summary Table are the ones that the particular program 

uses when running a test. 
  
*Note: It is possible to have no calibration data in the calibration menu if you calibrate 
a sensor with one program (for example, TRIAXIAL) and later use a different program 
(for example, ICON): Each program will always uses the calibration factors contained 
in its Summary Table. 
 
 

13. Q: How do I bleed the lines and get rid of air bubbles in the cell? 
 
A: To bleed the lines and get rid of air bubbles, follow these steps: 
 

1. Using the keypad and the LCD on the front of the FlowTrac-II, go to the main 
menu. 

 

 
 

2. Select Position (press 2 on the keypad). 
 

 
 

3. Select Control Valves (press 5).  
 

Position 
1. Empty  4. Jog 
2. Fill   5. Control Valves  
3. Initialize 

FlowTrac II.  Rev: xx.xx.xxxx   ID: # 
1. Monitor  4. Setup 
2. Position   
3. Control 
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4. Open the output Valve (press 1) and close the supply valve (press 4) if it is not 
already closed. 
 

5. Next, go back to the main menu by pressing Esc. 
 

6. Go back to the position menu and select Jog (press 4).  Use the up arrow to push 
water out of the flow pump into the output line until you see water dripping out.  
Visually inspect the line and keep on pushing the water out  until you get rid of all 
the air bubbles. 

 
 

14. Q: Before the permeation phase, how do I know that the external air pressure is 
correct? 

 
A: The external compressed air pressure must be equal to the cell pressure before the 

switch to the permeation phase otherwise: 
 
1. Air pressure <  cell pressure => The cell  water will go  out into the air line until the 

FlowTrac-II gets empty and the test stops 
2. Air pressure  > cell pressure => The air  will go   into the FlowTrac-II  line until the 

FlowTrac-II gets full  and the test stops 
 
 
 

Software 
 

1. Q: After running a successful test we ran into troubles with the report.  We were not 
able to generate a report because all links on the report pull-down menu are inactive.  
Are we missing something, or is the software not entirely installed? 

 
A: Use the following steps to generate a report. 
 
1. Once a test is finished or even while it is running, go to the File menu. 
2. Click on Load; this will load the test data on the open window on the desktop. 
3. Go back to Report.  You should see now the Graph, Settings, and Edit menus all 

activated. 
4. You can change units and scales, and edit the test data points. 
5. Remember that every time you change or edit something, you will need to save the 

file, and load it again. 
 
 

2. Q: The User’s Manual says that the Proportion Gain can be as high as 5 for soft soils and 
as low as 0.5 for stiff soils.  Also, the Integral Gain should probably be set to 0.1 for very 

Output Valve   Supply Valve 
1. Open    3. Open    
2. Close   4. Close   
Valve is open   Valve is closed 



FLOW TESTING © 2013 Geocomp Corp. 

Geocomp Corporation · 125 Nagog Park · Acton, MA 01720 · Tel 978-635-0012 · Fax 978-635-0266 

stiff samples.  What other values might be used and how are we going to decide on the 
best values to use?  Please clarify. 

 
A: It is possible to use any Proportional Gain (P-Gain) value from 0.5 to 5 and any Integral 

Gain (I-Gain) from 0.1 to 1.  (The Derivative Gain value of 0 should not be changed.)  The rate 
at which a load is applied at the beginning of a step depends on both the P-Gain and the I-
Gain: lower value = slower rate, higher value = faster rate.  The time to reach a target value 
increases by a factor of about 3 from a P-Gain of 0.5 to 5.  The table below gives general 
guidelines for P-Gain settings. 

 

Sample stiffness Recommended P-Gain 
value  

LOOSE /VERY SOFT 5.0 
MEDIUM SOFT/MEDIUM 2.5 

DENSE/STIFF 0.5 
 
In addition, the following information may help you to decide what value will be best for 

your sample.   
 
The graphs shown below are for loading curves generated during a test.  (They were 

generated from data dumped into a file after the test.)  Note that the time scale is not the 
same for the different soil types.  When possible, the target load/pressure should be reached 
in less than 0.5 min.  Consequently a high P-Gain setting is good for very soft soils.   

 
It is easy to reach the target load/pressure value for stiff soils.  However (as seen in the 

last two graphs), the target value may not be reached smoothly.  To help this situation, the I-
Gain (or both the I-Gain and P-Gain) can be decreased. 
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In addition, a “rule of thumb” for response time is given in Section 6.0 of ASTM standard 
D2435: Standard Test Methods for One-Dimensional Consolidation Properties of Soils Using 
Incremantal Loading. 

 
“Load application generally should be completed in a time corresponding to 0.01 t100 or 
less.  For soils where primary consolidation is completed in 3 min, load application should be 
less than 2 s.” 

 
To find out what the T100 value is for a step in a test, open the Test T100  window (by 

choosing the T100 option in the View menu) at the beginning of the step.  As soon as the 
ICONP program has gathered enough information, it will show the graphical determination of 
the T100 value on the window.  It will also list the T100 value in the Test Monitor window.  

 
To change a PID setting click PID on the Options menu to open the Load PID Settings 

window.  Replace the default value with the new value, click the Apply button and then close 
the window. 

 
 

3. Q: I noticed that the cell volume starts to fluctuate as soon as higher and higher cell 
pressure (greater than 900 kPa (125 psi) are being applied.  Why does it do that? 

 
A: Because of the "stiffness and compliance” of the testing system which is just a small 

volume of the tubing, we need to adjust the cell PID (Proportional Integral Derivative) 
parameter controls.  

 
They are under Options/PID/Cell Pressure. 
 
If you adjust the cell pressure proportional gain from to 1.00 to 0.25, you will see virtually 

no fluctuation in the pressure once it reaches the target value. 
 
The PID control parameters are adjustable due to the nature of the different soil types 

and large variations in their stiffness, from very soft peat and organic soils to highly over-
consolidated clays or even soft to medium rocks. 

 
The max PID value is 0.10 (very soft soils) and the minimum is 5.00 (very stiff soils). 
 

PID CONTROL  
 
Control of the pressure or load is accomplished by using a closed loop controller.  At 

equally spaced time intervals called the control loop period, the controller compares the 
target load or pressure to the measured load or pressure.  The loop error is the difference 
between the two.  The controller uses this error to compute and send a signal to the micro-
stepper motor in order to make adjustments to reduce the error by the next loop period. 

 
The signal to the micro-stepper controls the micro-stepper’s position.  The loop error 

computed by the controller at every loop period is nothing but the additional required load or 
pressure to eliminate the error by the next loop period.  In other words, the load rate is the 
error divided by the loop period. 

 
Signal = Error/Loop Period/Stiffness  
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GP = 1/Loop Period/Stiffness  
 
Signal (P) = GP * Error 
 
The above equation is the basic idea behind any proportional controller where GP is the 

proportional gain. 
 
The controller employed by this system is actually a PID controller, where P is for 

proportional control, I is for integral control and D is the derivative controller. 
 
 

4. Q: I calibrated my transducer and filled out the Calibration table under the Options 
menu.  However, I can't get the program to save the new calibration numbers.  When I 
open the file back up the old calibration numbers are still there.  How do I save the new 
calibration data? 

 
A: Go to File>Save As.  Save the file under a new name such as newtemplate.dat 
 
 

5. Q: During the test, a controller error message appears on the screen telling me that a 
limit switch is on; what should I do? 

 
A: Manually close the valve on the permeability cell connected to this FlowTrac-II unit.  

Depending on the status of the FlowTrac-II unit, refill if empty, or empty if full.  Re-apply the 
pressure from before the error message; reopen the valve and then click on the Retry button.  

 
 

6. Q: What is the purpose, in general, of the "Initialization" phase? 
 
A: Initialization is an important phase that: 
 
1. Allows the user to check the proper functioning of the entire system while it is only 

applying a small effective stress on the sample 
2. Detects early leaks, either through the rubber membrane, the fittings, or the in the 

cell (acrylic chamber not tightened, O-rings out of alignment…) 
3. Applies a small effective stress on the sample, so that the sample state of stresses is 

moved away from the failure line on a stress path diagram.  This will prevent any 
possible early set-up failure of the sample, especially for very soft clayey soils or very 
loose sands. 

 
 

7. Q: What typical magnitudes of stress would you apply during initialization, prior to 
beginning backpressure saturation? 

 
A: Typically you want to apply a small effective stress on the sample, such as 7 or 14 kPa 

(1 or 2 psi). 
 
 

8. Q: How long do I have to leave the initialization phase? 
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A: 60 minutes is a sufficient duration to detect any problem.  Please note that any phase 

duration starts from the moment that the desired stresses are reached.  If everything checks 
OK, you do not need to wait for the full 60 minutes; go to the Run menu and click on Next 
Step to manually override the automation process. 

  

 
  
 

9. Q: Can the software detect wrong values that are manually entered by the end user? 
  
A: Yes, the software program detects any erroneous data entry; examples include: 
  
1. Negative values for sample dimensions, calibration factors, and PID control parameters 
 
2. Zero values for sample dimensions, calibration factors (except for offset value), and PID 

control parameters 
 
3. Wrong Node ID number 
 
4. A malfunctioning sensor that it is giving an analog reading of either 0 (the minimum 

value) or 65535 (the maximum value) 
 
5. Any unit (LoadTrac-II or FlowTrac-II) that is not on. 
 
 

10. Q: I am running a test.  Do I need to wait until the end of the test to see the results? 
  
A: You do not need to wait until the end of the test.  While the test is running: 
 

1. Go to the File menu. 
2. Select Load. 
3. Go to the Report menu.  You should now be able to see the partial data up to the 

point when you did the Load. 
4. Repeat the above steps as the test progresses. 


